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Video 1: BPM con GeneXus

Este curso es una guia para principiantes para el desarrollo de aplicaciones BPM con GeneXus
17.

GeneXus 17 es una plataforma inteligente que simplifica el desarrollo de software,
automatizando todo lo automatizable. Es LOW-CODE, es decir que se escribe el menor cédigo
posibley luego mediante técnicas de inteligencia artificial GeneXus genera automaticamente el
codigo fuente, minimizando los tiempos de desarrollo, evolucion y mantenimiento de las

aplicaciones.

{Qué es BPM?
Business Process Management (BPM) es una metodologia que se enfoca en administrary
optimizar en forma continua las actividades y procesos de negocio de la organizacion.

{Qué es GeneXus BPM Suite?
Es una Suite para la gestion y optimizacién de procesos de negocio con la cual podras:
e Modelar tus procesos de negocio
e Automatizar, integrando sistemas y creando aplicaciones con Genexus
e Administrar, controlary gestionar tus procesos de negocio.
e Optimizar, identificar facilmente oportunidades de mejora.
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o o Desarrollo,
Analisis Estadistico Automatizacion
GeneXus flow Client Integracion
GeneXus Query GeneXus

Ejecucion y Monitoreo

GeneXus flow Client
+ Web & Smart Devices



Video 2: Descarga e instala GeneXus

(Se reutiliza el mismo video que se uso en el curso de Gx)

Video 3: Caso de estudio

Una agencia de viajes requiere una aplicacién que administre la reserva de boletos de avion de
sus clientes.

El proceso consiste en ingresar los datos de una reserva a través de un Operador de la agencia.
Si el cliente no esté registrado, el sistema lo debe asociar automaticamente a la reserva
previamente generada. A continuacion se debe realizar una verificacién de disponibilidad. Si el
resultado es positivo, se completa el proceso. De no haber disponibilidad, se debe retornar a la
tarea de reserva donde se pueden cambiar los detalles de la misma.

Este ejemplo simplificado tiene como objetivo mostrar la definicién de un diagrama de
proceso de negocio (Business Process Diagram) y su seguimiento, destacando la importancia
de representar un Workflow con la posibilidad de automatizar controles con la menor
intervencion de los desarrolladores.

En definitiva, con simples pasos, puedes construir robustas aplicaciones BPM utilizando
Genexus.

Pasos para modelar un proceso de negocio en Genexus:

Crear el diagrama de actividades que modela el proceso.
Crear los objetos que representan las tareas del workflow.
Asociar objetos al diagrama.

Ejecutar el proceso.

Desarrollemos juntos ahora, paso a paso, este caso de estudio.



Video 4: Creacion de una nueva aplicacion

Parte 1. Crear una Knowledge Base en GeneXus 17

Para comenzar a trabajar debes ejecutar GeneXus 17y crear una nueva Base de Conocimiento
(un nuevo proyecto GeneXus). Para ello debes seleccionar: File > New > Knowledge Base del

menu principal.

Se abrird un cuadro de didlogo. A modo de ejemplo, puedes nombrar a la Base de
Conocimiento “TicketReservation”.

Create Knowledge Base

Mame:

|T|d~:3¢ Reservation

b | Advanced »»

[ Create | Cancel

Presiona el botén “Create “ para crear tu base de conocimiento.




Video 5: Modelar un proceso de negocio

Parte 2. Modelar un proceso de negocio

2.1. Crear el diagrama de actividades que modela el proceso

El siguiente paso consiste en crear un diagrama de actividades que permita modelar el proceso
del caso de estudio.

Para ello debes seleccionar: File > New > Object en el mend principal (o Ctrl +N). Se mostrara
el siguiente cuadro de dialogo:

Mew Object H

Select a Categary: Select a Type:

Data Management Business Process Diagram
Uzer Interface

BFM

Chatbots

Resources
Documentation
Extensibility

Deploy

Reporting v

Represents the flow of a business process that occurs in real life.

MName: | Flight Ticket Reservation
Description: |Flig|'rl Ticket Reservation
Module/Folder: Root Module -

Create Cancel

T TrTTIeeT T T T TR TR R RS T S

Tal como se muestra, dentro de la categoria “BPM” encontrards el tipo de objeto “Business
Process Diagram”. Eligelo y ndmbralo “FlightTicketReservation”.

Luego de haber creado el objeto Business Process Diagram, debes incluir dentro de él los
simbolos que definirdn el proceso.

La notacion que se utiliza para los diagramas es BPMN (Business Process Modeling Notation)




A continuacién se brinda una descripcién basica de los simbolos principales para iniciar el

modelado:
=l Quick Access
B None Task
% Script Task
a |Jzer Task
Eﬂ Reusable SubProcess
(£ Embedded SubProcess
& Exclusive Gateway
& Parallel Gateway
@ None Start Event
@ None End Event
F_"?‘ Intermediate Timer Event

e Task: Tarea que permite representar un trabajo que se realiza en un proceso de
negocio. Se clasifica en tres tipos:
o None: Es el valor por defecto. Significa que alin no se ha definido si sera
ejecutada por un usuario o un Procedimiento.
o User: Indica que la tarea sera ejecutada por un usuario.
o Script: Indica que la tarea sera ejecutada por un Procedimiento.
e Start Event: Inicio de un proceso.
e End Event: Fin de un proceso.
e Gateway: Permite controlar cuando un proceso diverge o converge en varios
caminos.

Para marcar el inicio del proceso, debes arrastrar desde la Toolbox hacia el Diagrama un
simbolo “Start Event” como se muestra en la imagen:



@ Start Page X FlightTicketReservation = X LW T Toolbox a %

1=l Quick Access

& Nene Task

& Script Task

e a User Task

Eﬂ Reusable SubProcess
{3 Embedded SubProcess
@ Exclusive Gateway

Relevant Data | Documentation |

Diagram *

&% Parzllel Gatewa,

@ Nene Start Event

Mene End Event
65" Intermediate Timer Event

A continuacién debes insertar una Tarea que representa el ingreso de la Reserva.

@ SwrtPage X FlightTicketReservation * X v T Toolbox 2 x
Diagram * | Relevant Data | Documentation | 1= Quick Access -
-~ B MNone Task
% Script Task

( - ’ a User Task
E Reusable SubProcess
3 Embedded SubProcess

@ Exclusive Gateway

& Parallel Gateway

€ None Start Event

G None End Event

) Intermediate Timer Event

[ 3]

Task

Seleccionando la tarea puedes modificar su descripcion en la propiedad “Name” o

presionando F2 (ejemplo: “Reservation”).

Luego debes unir el inicio del proceso con la Tarea ingresada. Al poner el mouse sobre el icono
deinicio te aparecera un nodo, das clicy arrastras hasta unir a la tarea para indicar el flujo a

seguir como se muestra:

e

|

| Reservation



Tip:

Otra forma de asociar los elementos en el diagrama es haciendo clic, por ejemplo en el icono de

Inicio y elegir la actividad o el elemento que desees después de €|, sin soltar se arrastra en donde
se desea ubicar, como se muestra a continuacion:

- ®
¢ l
Q ¢ . .
e m . Task -;
3 L] :.le; - -

El siguiente paso consiste en evaluar si el cliente esta registrado o no. Para ello, debes insertar
un simbolo de tipo “Gateway” con la descripcion: Is a customer?

-

l

Feservation

|
&

|z & Customer?

Si el cliente esta registrado, el siguiente paso es indicar si la reserva esta o no disponible. Para

ello inserta una Tarea con la descripcidn “Reservation Availability” y luego un Gateway que
permite evaluar dicha disponibilidad:




-

‘ Reservation ‘

-

Is a Cugtomer?

8 Reservation
Losailability

-

Is available?

Sihay disponibilidad para la reserva solicitada, el proceso finaliza. En caso contrario, el flujo
debe volver a la tarea inicial para cambiar los detalles de la reserva:

:

44‘ el

-

Is & Cugtomer?

b

< Reservation
Awailabiliy

-

Is avallable?

@

Hasta este momento hemos modelado el caso en que el cliente ya esté registrado, veamos a

-

continuacion el flujo correspondiente a cuando no existe.



Video 6: Continuando con el modelado

Aln esta pendiente modelar la situacién correspondiente a si el cliente no existe. Para ello,
debes agregar una Tarea con descripcion: “Add Customer” a la cual se llega desde el Gateway
“Is a Customer” si éste evalla que el cliente no esta registrado.

l

-
—— Resenvation

|

/\ é A
< —_— Add Customer

Is a Cugtomer?

=
e Reservation
Lorailability

—é

Is ava|lable?

@

Una vez que se haya registrado el cliente habra que asignarlo de manera automética a la

reserva generaday luego validar la disponibilidad. Debes reflejar esto en el diagrama como se
muestra a continuacion mediante una tarea de tipo Script:

l

. .
—— Reservation

=

é
L e Add Customer
Isa Cuitomer? l

=
®  Reservation v Assi

ign i

Lorailzbility ¢ Customer

l l
—® S}

Is EVT able?

Como puedes observar, tan solo se ha agregado una Tarea llamada “Assign to Customer” unida

desde la tarea “Add Customer” y hacia la Tarea “Reservation Availability".
Guarda el diagrama (CTRL+S).
De esta manera has finalizado con el modelado del flujo del proceso.



Video 7: Creacion de objetos

2.2. Crear objetos que seran parte del proceso

Luego de haber definido el diagrama, es momento de crear los objetos que van a formar parte

del proceso.

Para crear un objeto Transaccién, selecciona: File > New > Object del menu principal. Se abrira

el siguiente cuadro de didlogo:

Mew Object X
Select a Category: Select a Type:
A [ £, Scbiype Group

User Interface 5 Data Provider [Ef Transaction
BPM E Data Selector

Chatbots B3 Data View

Resources .T. Domain

Documentation & Procedure

Extensibilty & Structured Data Type

Deploy

Reporting w

Describes an object or actor of reality, defining the structure of the database, business rules, and the Ul for data

manipulation.

Name: |C|.|5tomer

Description: |C|.|5tomer

Module/Folder: Root Module -

Create Cancel

TETITTT

Dentro del grupo “Data Management” elige el tipo de objeto Transaction y némbrala

“Customer”.

Al presionar el boton CREATE se creara la Transaccion y se mantendrd abierta y lista para que la

definas tal como se muestra en la siguiente imagen:

@ Start Page X Customer ™ X

ke Web Layout * | Rules | Events | Variables | —5I|:| Documentation | Patterns

MName Type Description Formula
EI-ECusb:mer Customer Customer

? CustomerCode Murmeric(4.0) Customer Code

#* CustomerMame Character(30) Customer Mame

# CustomerSurMame  Character(30) Customer Sur Mame

i ® CustomerAddress  Address, GeneXus Customer Address

Mullable

Mo
Mo
Mo
Mo



Donde:
CustomerCode* Es clave primaria y su propiedad Autonumber esté configurada con valor True.

Al salvar la Transaccion (CTRL + S) el (*) que se visualiza al lado del nombre de la Transaccién
en la pestafia superior desaparecera.

Ahora es momento de crear la Transaccion “Reservation” siguiendo los mismos pasos que
hiciste para crear la Transaccion Customer. Debera quedar tal como se muestra a continuacion:

@ Start Page X Reservation ™ X A
k: Web Layout | Rules | Events | Variables | Patterns
Mame Type Description Formula Mullable
EI-EResenraﬁnn Reservation Reservation

? ReservationCode Mumeric(4.0) Reservation Code Mo

- & ReservationDate Date Reservation Date Mo

- # ReservationFlightDate Date Reservation Flight Date Mo

- # ReservationQuantity Mumeric(4.0) Reservation Quantity Mo

- A CustomerCode Mumeric(4.0) Customer Code fes

- o CustomerMame Character(30) Customer Mame

- ® ReservationAvailable Boolean Reservation Available Mo
Donde:

ReservationCode* Es clave primaria y su propiedad Autonumber esta configurada con valor True.
CustomerCode En |a propiedad Nullable tiene valor Yes para admitir valores nulos.

Define ahora la siguiente regla en la Transaccién “Reservation”:

ReservationAvailableVisible = False if Insert;

Esto es porque se desea que el atributo ReservationAvailable no esté visible en el formulario de
la Transaccion cuando se inserta una reserva (ya que este atributo no se usa en ese momento
sino cuando la reserva ya esté ingresada y se quiere indicar si esta disponible o no).

Salva los cambios (CTRL +S).



@ Start Page X Reservation™ X
3'.'.:'..'5| % Web Layout E =_| :-'5:5£|—e:| Documentation | Patte

1 ReservationAvailable.Visible = False
z. if Insert;
SE

Para continuar con el flujo del proceso debes crear un objeto de tipo Procedimiento, pero eso
lo veras en el préximo video.

Video 8: Definiendo mas objetos

Para asignar un cliente a la reserva debes crear un nuevo objeto del tipo Procedimiento y
nombrarlo: AssignToCustomer.

MNew Object >
Select a Category: Select a Type:
Al AP L Subtype Group

User Interface 9 Data Provider Transaction
BPM EData Selector

Chatbats EData View

Resources .T. Domain

Documentation " Frossdus

Extensibilty & Structured Data Type

Deploy

Reporting v

Defines a program or routine that implemerts an algorithm, including database access, data updates, and

printing.

Name: |AssignTOCuslomer

Description: |Assign To Customer

Module/Folder: Root Medule -

Create Cancel

Debes definir lo que se detalla a continuacion en las diferentes secciones del Procedimiento:

Variables
e ReservationCode: Basada en el atributo ReservationCode.
e CustomerCode: Basada en el atributo CustomerCode.

Reglas
e Parm(in: &ReservationCode, in: &CustomerCode);

Source
For each Reservation




Where ReservationCode= &ReservationCode
CustomerCode= &CustomerCode
Endfor

(Se busca la reserva recibida por pardmetro y se asigna el Cliente
previamente creado en la transaccién Customer)

A continuacién puedes ver como debe quedar exactamente:

@ Start Page X :' AssignToCustomer ™ X

Rules * | Conditions | Variables | Help | Documentation |

Source

Layout

Type Is Collection Description
Standard Variables
CustomerCode Attribute:CustomerCode | Customer Code
i ® ReservationCode  Attribute:ReservationCode 1 Reservation Code

@ StartPage X _* AssignToCustomer® X
E:Lu':sl Layout Conditions | Variables | Help | Documentation |

‘ 1EI Parm(in: &ReservationCode, in: &CustomerCode};
2

@ StertPage X " AssignToCustomer® X

Source ™ _5;-CLIi| Rules ™ | Conditions | Variables | Help | Documentation |

> |

1EI For each Reserwvation

2 Where ReservationCode= &ReservationCode
3 CustomerCode= &CustomerCode

4 Endfor

Guarda el Procedimiento (CTRL +S).



Video 9: Asociar objetos al diagrama y crear datos relevantes.

2.3. Asociar los objetos al diagrama

El siguiente paso consiste en asociar los objetos a cada una de las tareas definidas en el
diagrama.

En la tarea “Reservation” tienes que asociar la Transaccion del mismo nombre (que permitira al
usuario ingresar una reserva que inicie el proceso). Para ello, selecciona latareay enla
propiedad Application debes asignar la Transaccién “Reservation” como se muestra:

Application Declaration X
Task: Reservation ~l Application: | inone) i_||
Name Reservation Data Mappings
Task Metadata Id 15 Parameter Relevant data
Task Metadata GUID eed3c2ab-391c-4Afch-acef-6d909...
Type User
Application (none)
SD Application (none)
Visible in history True oK l | Cancel
Select Objects x
Fillers
Pattem: || Type: Al -
Category:  "ALL | Module/Folder. -
[ Modified:
-
MName o | Type Module | Description Modified Dat | Import Diate
™| AppMasterPage Web Master Panel | Root Application Master Page 122201 20102021 11:39
P Customer Transaction Root Customer 200102021
™ PromptMasierPage ‘Web Master Panel  Foot_ | Prompt Master Page 204 | 20M0/2021 11:39
ralll 3] ink: Web Component Resct Recent Links web compe.. | 22082007 20102021 11:39
™ Reservation Transaction Root.  Reservation 2011072021 -
™ PFwdMasterPage \Web Master Panel | Root_ | Responsive Master Page | 06/062016_ | 20M0/2021 11:39
7 RwdPrompiMasterPage | ‘WebMaster Panel  FRoot. | Rwd Prompt Master Page  08/07/2020.  201M0:2021 11:33
% FwdRecentLinks Web Component Root Responsive Recent Links | 25072014, 20102021 11:39
1 selected object(s). B matching object{s).
New [_ox ]| coce




Concepto de Dato Relevante: [ os Datos Relevantes permiten definir variables globales al
proceso de negocio. Es decir, que los datos que esas variables contengan se podran
consultar o modificar a lo largo de todo el proceso.

Ahora tienes que asociar un dato relevante a la tarea “Reservation”. Esto permitira gestionar la
transferencia de informacion entre las tareas del flujo. En este caso el dato relevante a generar
es: ReservationCode.

En el cuadro de didlogo donde se asoci6 la transaccién podras observar la seccion “Data

Mappings”, en la columna Relevant Data da clic en el icono de & para asociar el Dato
relevante y después OK como se muestra en la Imagen.

Application Declaration x

Application: | Reservation

Data Mappings

Primary key attribute Relevant data
ReservationCode i ReservationCode €5 =:
Cancel

Como habras notado, ReservationCode se completé automaticamente (no has tenido que
digitarlo). Es una facilidad que provee automaticamente solamente para las claves primarias.
Es decir, hay un mapeo automatico entre el dato relevante y el atributo llave primaria.

Cuando se ejecute la Transaccion “Reservation” el dato relevante ReservationCode tendré
asociado el identificador de la reserva ingresada.

Después de asociar las transacciones para continuar definiendo el flujo hay que definir
Gateways, eso lo veremos en el siguiente video.



Video 10: Continuando con la asociacion de
objetos al diagrama

Para continuar definiendo el flujo hay que definir las condiciones a evaluar para cada uno de
los conectores que salen desde el Gateway “Is a Customer?”.

|
FlightTicketReservation * X o [-] oX
Data | Documentation | = l ¥ |Fi|tEf |
— |
~ ~ |
l Condition type Rule |
[ ]
™ Resenvation Text
i Condition editor =
(> 1 Reservation.CustomerCode >E3| B
i =]
ls @ Cutefner? H
|
~ = < . >
e Reservation
Auailabilty —
Cancel
l |

Como se muestra en la imagen anterior, debes seleccionar el conector que sale del Gateway “Is
a Customer?” y va hacia “Reservation Availability”. En su propiedad “Condition Rule” haz clic en

el simbolo ““I y abrird un editor de condicién donde debes definir lo siguiente:
Reservation.CustomerCode > 0
Esta condicion evalla si en la Transaccion Reservation, el CustomerCode fue completado con

algiinvalor (y como alli es clave fordnea, ese valor de cliente debe existir). Si eso ocurre, se
continla con la tarea “Reservation Availability”.



Evaluacion de condiciones: La condicion se puede definir de tres formas diferentes en
funcién a la complejidad de la evaluacion a realizar en el Gateway.

1. Definir una regla por cada conector: Es una expresion aritmética, que se puede
definir utilizando atributos de las Transacciones incluidas en los diagramas (la
opcidn que estamos usando) o mediante la evaluacion de datos relevantes, junto
con operaciones >,<,=, +,*.

2. Definir un procedimiento que evalte todos los caminos posibles: En las
propiedades de un Gateway podras observar la propiedad “Condition procedure”,
donde se puede asociar un procedimiento el cual evalle y decida el camino a
tomar. Los diferentes conectores tendran un valor dependiendo las rutas definidas
por el procedimiento.

3. Definir un procedimiento para cada conector: En vez de elegir la opcion Rule a
nivel del conector existe el tipo Procedure que permite definir un procedimiento
por cada camino.

Los 2 ultimos casos aplica para situaciones complejas lo cual da toda la potencia y
expresividad de GeneXus para evaluar la ruta.

Un diagrama puede evaluar el valor de una atributo directamente

Ahora hay que configurar el otro conector que sale desde el Gateway “Is a Customer?”y que va
hacia la tarea “Add Customer”:

FlghTicketReservation” X v
(| 2| F | Filter X

Sequence Flow Connector: 'Is a Customer?' -> "Add Cust...

7 ~
v | Condition type Default
é

ant Data | Documentation |

Text

Reservation ‘

I I
e—\ < — P{ é Add Customer ‘

Is a Cugtomer?

En su propiedad “Condition Type” elige el valor “Default” como se muestra. Esto significa que
sininguno de los otros conectores que tiene el Gateway se cumple, entonces este es el que se
seguira.

Después hay que asociar la aplicacion correspondiente a la tarea “Reservation Availability”:



e Application = la Transaccién “Reservation” y en ese mismo dialogo asigna el dato
relevante ReservationCode como lo haz hecho en la tarea “Reservation”

@& StartPage X FlightTicketReservation = X

ata | Documentation |

Diagram ™

PaN [~

Isa Cu‘-tomer?
L] 1 ]
(A ool
[] —Ti ]

\~ | Properties

2| F | Fitter

Task: Reservation Availability

MName
Tack Metadata Id

Tack Metadata GUID

Reservation Availability
23

464d0d14-7dbe-4ff1-aa7f-2f7d3...

> X X

Type User
Application Reservation
5D Application (none)

Si la reserva esta disponible el proceso finaliza. En caso contrario, el flujo vuelve a la tarea

inicial para cambiar los detalles de la reserva.

Selecciona el conector que va desde el Gateway “Is Available?” hacia la tarea “Reservation”

y en su propiedad Conditon rule ingresa:




ReservationAvailable= False

Esta definicion es una evaluacién, es decir que si la reserva no esta disponible, se volvera a la
tarea que implica modificar los datos de la reserva.

Por el contrario, el conector que va desde el Gateway “Is Available?” hacia el final del proceso
debe tener un conector del tipo Default:

G‘TargetEnwronmEnt-—I‘_'l FlightTicketReservation® X

Diagram * | Relevant Data | Documentation ‘

~ Sequence Flow Connector: 'Is available?' > 'EndEvent
/'Comﬁﬁnnlype I Default
e Text

I
Is ava,fable?

O

Procede a configurar la tarea “Add Customer”.
e Application = Transaccion “Customer”y en el mismo didlogo asigna el dato relevante

CustomerCode.
@ StartPage X FlightTicketReservation* X \/ & Properties L
Diagram * | Relevant Data ‘ Documentation | £ ;l ? |Filter Xt
v I Task: Add Customer ~
é- i I Add Customer
¢ L —
= Task Metadata Id 30
Is a Cugtomer? . - =) ack Hisadata e
¢ 4 Task Metadata GUID | 14a10aa8-9aae-4df0-32846-4f1d6...
F % Type User
Reservation - Assignio
Azilability ‘Customer (nene)
SD Application {none) /
Application Declaration / X |
—® (= J P s i
7
s avTabie. Data Mappings
Primary key attribute Relevant data
O CustomerCode CustomerCode +4

Cancel

Para completar el flujo, falta definir la asignacion del cliente a la reserva. Asi que, luego de la
insercion del cliente, éste debe asignarse de forma automatica a la reserva. Para ello, a la tarea
“AssignToCustomer” debes asignarle el Procedimiento de igual nombre.



Configura entonces para la tarea “AssignToCustomer” lo siguiente:

e Procedure = el objeto AssignToCustomer
e Datos relevantes: ReservationCodey CustomerCode.

FlightTicketReservation ™ X »s || Properties 7
l ¥ ‘Fl\ter

+ S ~ Task: Assign to Customer

QH é Add Customer ‘ Narne Assign to Customer

ant Data | Documentation ‘

> X X

Task Metadata Id 32
Is a Cugtomer?
T Task Metadata GUID | 6593e439-24bf-44e4-a84d-9d5fc...
8 ] & 1 4 Type Script
Resenvation | | Assignio
Loszilability Customer 3 Procedure (none)
~ 500 L Visible in history True
Roles
5 E O Application Declaration
|s available? Application: §| AssignToCustomer
Data Mappings
In: ReservationCode ReservationCode
In: CustomerCode CustomerCode > 7]

Ya han quedado asociados todos los objetos a cada una de las tareas del flujo.

Salva (CTRL+S)



Video 11: Ejecucion

Parte 3. Ejecutar el diagrama

Selecciona Build > Build All del MenU Principal, enseguida aparecerd el siguiente cuadro de
dialogo:

GeneXus Account Authentication b

Create a GeneXus account or Sign in

Please, enter your email address below:

] Remember me

Do you have a GeneXus account 7

@ Mo, I'm new in GeneXus, | need to create an account

(O Yes! | already have one and my password is;

Forgot your password?

Create Account

Si no tienes un usuario GeneXus lo puedes crear en este momento, si ya tienes una cuenta lo
ingresas.

Como parte del proceso, GeneXus evaluara el impacto causado por las definiciones en la Base
de Conocimiento y mostrara el informe de nombre Analisis de Impacto, este informe nos esta
mostrando que cambios estructurales deben realizarse en la base de datos ; presiona el botén

“Create” para que se cree la base de datos normalizada y se proceda con la generacion de los
programas.

Para ejecutar el proceso haz clic con el boton derecho del mouse sobre el nombre del
diagrama que aparece en el arbol de la ventana “KB Explorer”y elige la opcion “Run’:



® s X
am

Open:| | Relew:
“a TicketReservation ——
Root Module
GeneXus
‘workflow
::- AssignToCustomer
Customer
Associated Tables
FlightT ¢
Reservation Mew 4
ola Domains D Cpen F12
o References Cpen Part ki
1 Customization Copy CTRLC
Documentation
X Cut CTRL+X
0
¥ Delete SUPR L
Save As... L
E}j References CTRL+F12 A
History CTRL+MAYUSCULAS+H
@ Properties F4 !
Run Fo b
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A continuacion, GeneXus realizard las acciones necesarias para ejecutar este diagrama:

Actualizar objetos de flujo de trabajo
Especificar objetos

Generar objetos

Compilar objetos de flujo de trabajo

Impactar el diagrama en la base de datos

El que se realicen o no todos estos pasos dependera de los cambios realizados; es decir, un
cambio en el diagrama provocara que todos sus objetos sean especificados y generados,
impactando el diagrama.



Video 12: Utilizar la bandeja de entrada

Una vez ejecutado el diagrama se abrird automaticamente un navegador con la aplicacion
como se muestra en la siguiente imagen:

Tuesday 15 June 2021 - 03:44:34 AM W Workflow

L DESKTOP A INBOX (P New iz Execute &7 Send More Actions -

INBOX -

::' r\’;‘ Created ¥

OUTBOX
Flight Ticket Reservation Reservation 06/15/21 10:4...

MY PROCESSES

MY PERFORMANCE

) PROCESS MANAGER ~
& EVENT VIEWER v
[[[ sTaTISTICS ~

1-10f1

La ejecucidn por defecto es con un ambiente en Prototipo, por lo cual se genera una nueva
instancia del proceso permitiendo al desarrollador (Prototyper) realizar todos los pasos sin
definir roles o asignacién de usuarios.

A continuacién se muestra el flujo del proceso para ambos casos: el primero corresponde a un
cliente que requiere ser registrado en el sistema y el segundo a un cliente que ya esta
registrado.



Video 12 Primera ejecucion

Caso 1: El cliente necesita ser registrado

Al ejecutar la aplicacion se muestra la bandeja de entrada con una tarea lista para ser
ejecutada. Lo primero que debes hacer es seleccionar la tarea y presionar el botén Execute
(otra opcion es hacer doble clic sobre la tarea). Se abrira el objeto asociado (Reservation) para
que ingreses los detalles de la reserva. Debes dejar el campo CustomerCode vacio (el cliente
alin no esté registrado).

CH

INBOX () New | Execute | 571 Send More Actions -

{ :] C/‘ Created W

=)

Flight Ticket Reservation Reservation 06/15/21 10:4...

1-10f1

ain.aspu



RESERVATION

Reservation
& ¢ » » SELECT
Code 0
Date 061721
Flight Date 0621721
Quantity 2
Customer Code 0

Customer Name

CONFIRM CANCEL

Pulsa CONFIRM. Veras un mensaje que indica que los datos se han afiadido con éxito, luego

debes pulsar el icono de cerrar de la parte superior derecha X para volver a la bandeja de
entrada. La tarea fue ejecutaday solo resta completarla. Haz clic en el botén Send:

INBOX @ New {5 Execute | &7 Send More Actions ~

J Q) @ Created ¥

Flight Ticket Reservation Reservation 06/15/21 11:39 FM

Ahora se evaluaré la condicion del Gateway y como no existe el cliente deberas registrarlo. Para

comprobarlo, selecciona Execute:



INBOX @ New [ Execute] &1 Send More Actions ~ 2

) "_“/‘ Created ¥

Flight Ticket Reservation Add Customer 06/16/21 10:15 PM

CUSTOMER

&« < » » SELECT

Code 0
Name John

Sur Name Smith

Address Av. Brazil 23465

CONFIRM CANCEL

Completa los datos del cliente. Presiona CONFIRM y veras un mensaje que indica que los datos

se han affadido con éxito. Presiona el icono de cerrar < para cerrar el formulario de ingreso
del cliente.

Para completar la tarea haz clic en el botén Send.

Al completar la tarea “Add Customer”, acorde a lo definido en el flujo, se ejecutara
automaticamente el Procedimiento “AssignToCustomer” asignando el cliente a la reserva.

La siguiente tarea del flujo es “Reservation Availability”. Presiona Execute para comprobarlo:



INBOX i5; Execute | &1 Send More Actions » P

@l @) @ subject Task Created W

Flight Ticket Reservation Reservation Availability 0eMe/21 10:19 PM

Se abriré la Transaccion Reserva (asociada a la tarea “Reservation Availability”) mostrando
ahora el checkbox Availability:

RESERVATION

Reservation
« < > » SELECT
Code 1
Date 01721
Flight Date 0621721
Quantity 2
Customer Code 1 U
Customer Name John
Available

CONFIRM CANCEL DELETE

Debes marcar la reserva como disponible. Presiona CONFIRM y veras un mensaje informando

que los datos se actualizaron exitosamente. Presiona el icono de cerrar x.



Presiona Send y al terminar esa tarea finaliza el proceso.



Video 13: Segunda ejecucion

Caso 2: El cliente ya esta registrado

Crea una nueva tarea haciendo clic en la opcion “New” de la bandeja de entrada como se
muestra a continuacion:

INBOX @ New Q) Execute & Send More Actions « P
( I. (@ @ Subject Task Created W

MEW PROCESS X

Select Process/Task:

I\Tj:fI ._. Search

= Flight Ticket Reservation

Subject

[ coea |

]

Selecciona “Flight Ticket Reservation” y presiona OK.

En la bandeja de entrada veras la nueva tarea (Reservation). Presiona Execute o doble clic
sobre ella para ejecutarla.



RESERVATION

Reservation
« < » » SELECT

Code 0

Date 0617121

Flight Date 11721121
Quantity 3

Customer Code 1

Customer Name John

Ingresa los detalles de la reserva con un cliente existente. Presiona CONFIRM y veras un

mensaje que indica que los datos se han afladido con éxito. Pulsa cerrar X paravolvera la
bandeja de entrada. Para completar la tarea haz clic en el boton Send.

A continuacion, se evalla la condicion del Gateway y el workflow sigue a “Reservation
Availability”. Ejecuta esta tarea.

INBOX () New | 1 Execute | &7 Send More Actions «

™ :_‘.:?.._: @ Created W

Flight Ticket Reservation Reservation Availability  08/16/21 10:34 PM



Con lafinalidad de probar todo el flujo definido, asume que no esta disponible la reserva (no
marques el checkbox “Available”) y presiona CONFIRM:

RESERVATION

Reservation

« ¢ » » SELECT

Code 2
Date 06/16/21 | [g5]

Flight Date 12121 | @

[}

Quantity

Customer Code 1

Customer Name John

Available O

CONFIRM CANCEL DELETE

Esto implica que se retorne a la tarea inicial para editar la reserva (cambiar sus datos para

volver a empezar con el flujo). Pulsa cerrar X paravolver a la bandeja de entrada. Presiona
Send. Puedes comprobar que se abre la Reserva para editarla.

iFelicidades, has creado tu primera aplicacion BPM en GeneXus 17!



Video 14: Seguridad

Parte 4. Definicion de la Seguridad

Disclaimer: Para poder realizar lo que se propone en esta seccion en cuanto a la asignacion de
diferentes roles a los usuarios es necesario contar con licencias de usuarios de GXflow en la version
full.

Igualmente se sefiala a modo informativo para mostrar cdmo se deben configurar la asignacion de
roles a tareas y usuarios.

Para este sencillo ejemplo solo se maneja un perfil: El “Operador” de la Agencia. Este perfil es
representado como “Rol” (Preferences > Workflow > Roles):

Preferences
% TicketReservation
i TicketReservation
+{1 Net Environment
Back end
D Front end
f Deployment
GeneXus Cloud

=2 Patterns

=]

LY
I &3, Foles
Documents
% Calendars

'« ) Notification templates

Al presionar doble clic en “Roles” aparecera una pantalla donde podras insertar el rol.

Presiona ENTERYy se abrird una linea debajo Roles para insertar el rol Operator:

@ Start Page X &a Roles X

Name Description
&5 Roles

El siguiente paso es asociar el Rol a cada una de las actividades del usuario. Para ello debes
seleccionar la Tarea y en su propiedad “Roles” dar clic y asociar como se muestra:



FlightTicketReservation * X

ant Data | Documentation

A Task: Reservation ~ |
Mame Reservation
Tack Metadata Id 15

Task Metadata GUID | eed3c2ab-391c-4cb-acef-6d9099...

! ) ! Type User

Application Reservation
] 877 5D Application (none)
.| Reservation Visible in history True
= . Subject rule |
e Assign roles to task *
Is & Cugtomy
I X | I
& Resenaig |4 Oversdr
Aovailabilty
< Remave

e ok |l cancel
Is ava‘fabk

Repite el proceso para AddCustomer, Reservation Availability e inclusive el evento Start. Al
finalizar salva los cambios (CTRL +S).

Una vez asignado el rol estaras en condiciones de probar la aplicacion tal como sera ejecutada
en produccion. Para eso debes cambiar el modo de ejecucion por defecto “Prototyper” y
seleccionar “StandardClient”. En la seccion Preferences da clic en Environmenty en sus
propiedades en el grupo “Workflow” cambia el valor por defecto de la propiedad “Execution
Mode” como se muestra:



Preferences
% TicketReservation
"2 TicketReservation
o} .NetEnvironment
Back end
[] Front end
4 Deployment
GeneXus Cloud
£ Patterns
1 o Workflow
5 Roles
I3y Documents

[ Calendars

(2 Notification templates

Ejecuta el diagrama.
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Video 15: Ejecucion y monitoreo

Podras observar que en lugar de abrir el cliente para prototipar se abre una pagina de login de

GXflow:

GXflow"

Role

SIGN

IN

FORGOT YOUR PASSWORD?

64*%8 Add Customer |

Isa Cuimmer? T
A ¥ fssiond
Auailabity Customer

l

@

5| | Fitker X

User interface
Web interface
HTML Document T HTML 5
Compatibility
Web Compatibility
Parameters Style | Named
Test
Generate Code Cover; No
Run Tests After Build | False
Web
Full page sereenshe False
Base URL
Verify stops executi True
Screenshot saving 1 OnError
HTML saving mode OnError
File Upload Base Pa
Workflow

Business processes na TicketReservation

Deploy business proci SE et r e A T

Create new versions ¢ Yes



Ingresa con el usuario administrador para insertar el usuario que formara parte del sistema.

User: WFADMINISTRATOR

Password: WFADMINISTRATOR

Selecciona “Management Console > User” como se muestra a continuacion:

Thursday 17 June 2021 - 06:36:44 AM W Workflow

[ DESKTOP v INBOX (P New “iz Execute 871 Send More Actions -
&) PROCESS MANAGER ~ —~
() @) Created ¥

E& EvENT VIEWER v
[[[ sTaTISTICS v
& BAcCKEND A%
[2] MANAGEMENT CONSOLE ~

USERS |

ROLES

ORG. UNIT DEFINITIONS

Selecciona la opcion: New. Se desplegard un pop up donde registrar los datos del usuario.



USERS ozo Roles /A, Org.Units More Actions -

Id Name Email

WFADMINISTRATOR Workflow Administrator
NEW USER X
GENERAL AVAILABILITY CERTIFICATES
User USER1
Name Charles Wilson
Email cwilson@correo.com
Password =~ | =eess
R. Password wared
User must change password at next logon OTrue
@False
canceL
r

Ahora deberas asociar el rol correspondiente al perfil del usuario.




USER ROLES
[] cerente

D GXflow Administrator

[] exfow Backend Administrator
[] exflow Form Designer

[] Gxflow manager

[] exflow Manager Read Only
|:| GXflow Prototyper

[] exfow Security Administrator
[] manager

|Z Operator

o] owcer |

Una vez asignado el rol, cierra la sesién del administrador e ingresa con USER1.

GeneXus

GXFflnr

SETTINGS

Account

Settings r

Sign Out
54 AM




GXflow’

USER1

-----

Role v

SIGN IN

Observa que alingresar al cliente figura:

e Nombre del usuario que hizo login.
e Desktop del lado izquierdo.
e Permisos para crear una instancia del proceso.

GeneXus

GXfl’OW” Thursday 17 June 2021 - 05:28:45 AM C Charles
1 DESKTOP ~ INBOX @ Execute &7 Send More Actions |
INBOX . .
l_\l_/_l Q) Created W
QUTBOX

MY PROCESSES

MY PERFORMANCE

Ingresa una reserva, guarda los cambios pero no termines la tarea (Send). Cierra la sesion de
USER1 para ingresar nuevamente con el administrador (WFADMINISTRATOR).



El usuario administrador podréd monitorear los procesos que se ejecutaron o que estan

actualmente en ejecucién (ProcessManager > Process ).

Selecciona el proceso y haz clic en More Actions > History:

GeneXus W
Thursday 17 June 2021 - 07:45°01 AM Workflow
GXflow -
) PROCESS MANAGER ~ PROCESSES @ Abort O' Reactivate @ Suspend More Actions «
G Resume
PROCESSES OoGa 40 History I
! High Priority
ASKS Flight .. FlightTi._. 10 running  Workflow Administ. . o
| Low Priority
e .
Flight T... FlightTi... 10 running  Workilow Administ... | & Change Deadline Al
A P N I PO

BUSINESS EVENTS

Podras observar que la tarea Reservation esta asociada al usuario “Charles Wilson” ademas de
indicar el estado en que se encuentra la tarea, fecha de creacién y de finalizacion.

HISTORY
(\ Comments [Z Consult ¢ Conditionals BE Optionals More Actions ~
@ @ Created A
[ completed Workflow Engine 06/17/21 12:32 AM 06/17/21 12:32 AM
Reservation in process Charles Wilson 06/17/21 12:32 AM




En caso de que Charles Wilson no pueda seguir con el flujo de trabajo por ausentarse, puede
delegar temporalmente sus tareas mediante la funcionalidad “Out of Office”. Para hacer esto,
solamente debe hacer clic en su nombre de usuario en la esquina superior derecha de su bandeja
de entrada y en el pop up de configuracién que aparece debe dar clic en su cuenta (Account).

Wednesday 24 November 2021 - 11:22:15 AM C

SETTINGS

o Charles Wilson
n
Account

Settings

Sign Out

Posteriormente seleccionar la propiedad User is currently out of the office y confirmar.

Tendra la posibilidad de elegir un rol o usuario como suplente y de esta forma se le pasan todas
las tareas pendientes al suplente y cuando vuelve el usuario titular se le regresan todas aquellas
tareas que no se hayan terminado aun.



ACCOUNT
Mame Charles Wilson -

cwilson{@correo.com

Cuser is currently in the office

®ser is currently out of the office

Haco N AEFARARERE AR RS

R Passwar T

Video 16: Estadisticas

Estadisticas: Permiten obtener informacion en forma gréfica del estado de los procesos de
negocio, es decir, conocer la cantidad de procesos que fueron completados en un periodo de
tiempo, los que fueron abortados, los que no fueron completados a tiempo, la cantidad de
tareas completadas por usuario, la duracion de los procesos, tareas, etc.

Para ver las estadisticas haz clic en “Statistics” y encontraras diferentes categorias a analizar, en
este caso selecciona “Process Analysis”™:



[[[ stamisTICS A
PROCESS ANALYSIS
TASK ANALYSIS
PROCESS PERFORMANCE
TASK PERFORMANCE

TEAM PERFORMANCE

* navega entre las opciones del menu principal y conoce un poco mas de lo que ofrece el
cliente de GXflow.

Video 17: ; Qué sigue?
- Contactenos

o Contactenos en nuestras oficinas o a través de nuestros socios de ventas en
genexus.com/contactus

We really hope we hear from you soon!

V2 o A Yo


http://genexus.com/contactus

